Read this User’s Guide before you start using your P-touch.  
Keep this User’s Guide in a handy place for future reference.  
Please visit us at support.brother.com where you can get product support and answers to frequently asked questions (FAQs).
INTRODUCTION

Thank you for purchasing the P-touch D450. Your new P-touch is an easy to operate, feature packed labelling system that makes creating professional, high quality labels a breeze. This manual contains various precautions and basic procedures for using this labeller. Read this manual carefully before using and keep in a handy place for future reference.

Federal Communications Commission (FCC) Declaration of Conformity (For USA Only)

<table>
<thead>
<tr>
<th>Responsible Party</th>
<th>Brother International Corporation</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>200 Crossing Boulevard</td>
</tr>
<tr>
<td></td>
<td>Bridgewater, NJ 08807-0911, U.S.A.</td>
</tr>
<tr>
<td></td>
<td>TEL : (908) 704-1700</td>
</tr>
</tbody>
</table>

declares, that the products

<table>
<thead>
<tr>
<th>Product Name</th>
<th>Brother P-touch Electronic Labeling System</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model Number</td>
<td>PT-D450</td>
</tr>
</tbody>
</table>

comply with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio/TV technician for help.

Important

- The enclosed interface cable should be used in order to ensure compliance with the limits for a Class B digital device.
- Changes or modifications not expressly approved by Brother Industries, Ltd. could void the user’s authority to operate the equipment.
For Australia Only:

**Support** - For technical support of your Brother Product other than what you can resolve through the User’s Guide, Please visit our Web Site or support Web Site (see below) to find an answer to FAQs/Troubleshooting.

Alternatively, please contact the Product Support Centre for any customer care/technical support enquiry.

**To contact Brother International (Aust) Pty Ltd for support on a Brother product**

Please see the details listed below:

Product Support Centre: **Australia**
Brother International (Aust) Pty Ltd
Phone: 02 8875 6000
Fax: 02 9870 7223
Brother support website: [support.brother.com](http://support.brother.com)
Email: To submit an e-mail enquiry, visit [www.brother.com.au](http://www.brother.com.au), go to Service and Support area and follow the prompts to contact technical support.

Our Technical Support Consultants are available 5 days a week by phone during the hours of 8.30am to 5.00pm (EST/EDST) Monday to Friday.

---

**Compilation and Publication Notice**

Under the supervision of Brother Industries, Ltd., this manual has been compiled and published, covering the latest product’s descriptions and specifications. The contents of this manual and the specifications of this product are subject to change without notice.

If new versions of the D450 software become available, this manual may not reflect the updated features. Therefore, you may find that the software and the contents in this manual are different.

Any trade names and product names of companies appearing on Brother products, related documents and any other materials are all trademarks or registered trademarks of those respective companies. BROther is either a trademark or a registered trademark of Brother Industries, Ltd.
INTRODUCTION

Contents

General Description ............................................................................................... 3
Safety Precautions ................................................................................................. 4
General Precautions .............................................................................................. 6

GETTING STARTED ...................................................................... 7
Unpacking Your P-touch ....................................................................................... 7
LCD Display & Keyboard ..................................................................................... 7
Power Supply and Tape cassette ......................................................................... 9
  When using AC adapter (AD-E001) ............................................................... 9
  When using six new AA alkaline batteries (LR6) or fully charged Ni-MH batteries (HR6) ............................................................................................... 9
  Insert a Tape Cassette ................................................................................. 10
Turning Power On/Off ......................................................................................... 11
Setting Language and Unit ............................................................................... 11
  Language ...................................................................................................... 11
  Unit ........................................................................................................... 11
Feeding Tape ....................................................................................................... 11
Setting LCD Display ........................................................................................... 11
  LCD Contrast .............................................................................................. 11
  Back Light ................................................................................................. 12
How to use the P-touch ....................................................................................... 12
  Create a label with the P-touch ............................................................... 12
  Create a label by connecting your labeller to a PC ...................................... 13

EDITING A LABEL .................................................................. 15
Entering and Editing Text .................................................................................... 15
  Entering Text from the Keyboard ............................................................... 15
  Adding a New Line ...................................................................................... 15
  Adding a New Block .................................................................................. 15
  Deleting Text .............................................................................................. 15
  Inserting a Tab ........................................................................................... 16
  Using Text Reminder ................................................................................ 16
  Deleting Text Reminder Memory ............................................................. 17
  Changing Text Reminder Setting ............................................................. 17
Entering Symbols................................................................................................. 17
  Entering Symbols Using the Symbol Function ............................................. 17
  Setting Symbol History ............................................................................ 17
Entering Accented Characters .......................................................................... 19
Setting Character Attributes ([Font]/[Size]/[Width]/[Style]/[Line]/[Align]) .............. 20
  Setting Character Attributes by Label ....................................................... 20
  Setting Character Attributes by Each Line ................................................. 20
  Setting Auto Fit Style ............................................................................... 22
Setting Frames .................................................................................................. 22
Setting Label Attributes ([Length]/[Cut Option]/[Tab Length]) ......................... 24
INTRODUCTION

Using Auto-Format Layouts ................................................................. 24
Using Templates .................................................................................... 24
Using Block Layouts ............................................................................ 27
Creating a Barcode Label ..................................................................... 30
Setting Barcode Parameters and Entering Barcode Data .................... 30
Editing and Deleting a Barcode .......................................................... 32

LABEL PRINTING ........................................................................ 33

Previewing Labels ............................................................................... 33
Printing Labels ..................................................................................... 33
  Single and Multiple Copy Printing .................................................... 33
  Numbering Printing ......................................................................... 34
  Mirror Printing ................................................................................ 34
Setting Tape Cutting Options .............................................................. 34
  [Large Margin]/[Small Margin]/[Chain]/[No Cut]/[Special tape] ........ 34
Adjusting the Label Length .................................................................. 36
Printing from the Label Collection ..................................................... 37
  Printing a label from the label collection stored in the P-touch ......... 37
  Downloading a new Label Collection Category ............................... 38

USING THE FILE MEMORY ......................................................... 39

Saving Label Files .............................................................................. 39
Printing, Opening, Deleting a Saved Label ........................................ 39
  [Print] ............................................................................................... 39
  [Open] ............................................................................................ 39
  [Delete] ......................................................................................... 39

RESETTING & MAINTAINING YOUR P-TOUCH .............................. 40

Resetting the P-touch ........................................................................ 40
  Resetting the Data Using the home key .......................................... 40
  Resetting the Data to Factory Settings Using the P-touch Keyboard ... 40
Maintenance ........................................................................................ 41
  Cleaning the Unit ............................................................................ 41
  Cleaning the Print Head ................................................................. 42
  Cleaning the Tape Cutter ............................................................... 42

TROUBLESHOOTING ................................................................. 43

What to do when .................................................................................. 43
When an error message appears on the display .................................. 44

APPENDIX ..................................................................................... 45

Specifications ...................................................................................... 45
System Requirements .......................................................................... 46
General Description

Tape cassette compartment cover
Tape viewer
LCD display
Tape exit slot
Keyboard
Tape cassette compartment
Tape cutter
Release lever
Print head
Battery compartment cover
USB port
AC adapter socket
Battery compartment
Safety Precautions

To prevent injury and damage, important notes are explained using various symbols. The symbols and their meanings are as follows:

| ![WARNING] | Indicates a potentially hazardous situation which, if not avoided, could result in death or serious injuries. |
| ![CAUTION] | Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injuries. |

The symbols used in this manual are as follows:

| ![Action NOT allowed] | DO NOT touch a given portion of the product. |
| ![Mandatory action] | Unplugging is required |
| ![DO NOT disassemble the product.] | Alerts to the possibility of electrical shock |

### WARNING

Follow these guidelines to avoid the risk of fire, burns, injury, electric shocks, rupture, overheating, abnormal odours or smoke.

- **Always use the specified voltage and the suggested AC adapter (AD-E001) for the P-touch to prevent any damage or failure.**
- **Do not touch the AC adapter and P-touch during a thunder storm.**
- **Do not use the P-touch/AC adapter in places of high humidity such as bathrooms.**
- **Do not place heavy objects on, or damage the power cord or plug. Do not forcibly bend or pull the power cord. Always hold the AC adapter when disconnecting from the power outlet.**
- **Make sure that the plug is fully inserted to the power outlet. Do not use an outlet that is loose.**
- **Do not allow the P-touch/AC adapter/power plug/batteries to get wet, for example, by handling them with wet hands or spilling beverages on to them.**
- **Since loss of eyesight may result when leaked fluid from batteries gets into your eyes, immediately rinse your eyes with a large amount of clean water, and then seek medical attention.**
- **Do not disassemble or modify the P-touch/AC adapter/batteries.**
- **Do not allow a metal object to contact both the plus and minus ends of a battery.**
- **Do not use sharp objects, such as tweezers or a metallic pen, to change the batteries.**
- **Do not throw the batteries into fire or expose to heat.**
- **Disconnect the AC adapter and remove batteries immediately and stop using the P-touch if you notice abnormal odour, heat, discoloration, deformation or anything unusual while using or storing it.**
INTRODUCTION

## WARNING

- Do not use a damaged or leaking battery as the fluid may get on your hands.
- Do not use a deformed or leaking battery or one whose label is damaged. There is a possibility of generating heat.
- Do not touch metal parts around the print head immediately after printing.
- When the P-touch is not being used, store it out of the reach of children. In addition, do not allow children to put the P-touch parts or labels in their mouths. If any object has been swallowed, seek medical attention.
- Do not use a damaged adapter cord or power plug.
- Do not use the P-touch when a foreign object enters the P-touch. If any foreign object enters the P-touch, disconnect the AC adapter and remove the batteries, and contact Brother customer service.

## CAUTION

Follow these guidelines to avoid personal injury, liquid leakage, burns or heat.

- Do not touch the cutter blade. If leaked fluid from batteries gets on your skin or clothes, immediately rinse them with clean water.
- Remove the batteries and disconnect the AC adapter if you do not intend to use the P-touch.
- Do not use a battery other than that specified. Do not use combinations of old and new batteries or combinations of different types, different charging levels, different manufacturers or different models. Do not insert a battery with the polarity (+ and -) reversed.
- Do not drop or hit the P-touch/AC adapter.
- Do not press on the LCD display.
- Do not put your finger inside the P-touch when you close the tape cassette compartment cover or battery compartment cover.
- Before using Ni-MH rechargeable batteries, carefully read the instructions for the batteries and battery charger, and be sure to use them correctly.
- When using Ni-MH rechargeable batteries, charge the batteries with a specialised battery charger before using the batteries.
General Precautions

• Depending on the location, material, and environmental conditions, the label may unpeel or become irremovable, the colour of the label may change or be transferred to other objects. Before applying the label, check the environmental conditions and the material.
• Do not use the P-touch in any way or for any purpose not described in this guide. Doing so may result in accidents or damage the P-touch.
• Use only Brother TZe tapes with the P-touch. Do not use tapes that do not have the TZe mark.
• Only use a soft, dry cloth to clean the labeller; never use alcohol or other organic solvents.
• Use a soft wipe to clean the print head; never touch the print head.
• Do not put any foreign objects into the tape exit slot, AC adapter connector or USB port, etc.
• Do not place the P-touch/batteries/AC adapter in direct sunlight or rain, near heaters or other hot appliances, in any location exposed to extremely high or low temperatures (e.g., on the dashboard or in the back of your car) or high humidity, or in dusty locations.
• Do not apply excessive pressure to the cutter lever.
• Do not try to print if the cassette is empty; it will damage the print head.
• Do not pull the tape while printing or feeding; it will damage the tape and the P-touch.
• It is recommended that you use the USB cable supplied with the P-touch. Should another USB cable need to be used, ensure it is of high quality construction.
• Any data saved in memory will be lost due to failure or repair of the P-touch, or if the battery expires.
• The P-touch is not equipped with a charging feature for rechargeable batteries.
• The printed text may differ from the text that appears in the LCD.
• The length of the printed label may differ from the displayed label length.
• When power is disconnected for two minutes, all text, format settings and any text files saved in the memory will be cleared.
• You can also use Heat Shrink Tube in this model. Check the Brother website (www.brother.com) for further information. You cannot print frames, pre-set P-touch templates, or use certain font settings when using Heat Shrink Tube. Printed characters may also be smaller than when using TZe tape.
• Be sure to read the instructions provided with Fabric Tape, Strong Adhesive Tape or other special tapes and observe all precautions noted in the instructions.
• A protective clear plastic sticker is placed over the display during manufacturing and shipping. This sticker should be removed prior to use.
GETTING STARTED

Unpacking Your P-touch

Carton Contents

- P-touch
- Starter Tape Cassette
- AC adapter
- USB Cable
- User’s Guide

LCD Display & Keyboard

The default language is [English].
## NOTE

- When the caps mode is on, all characters you type will be in uppercase letters.
- The text that you enter can be up to 280 characters in length.
- Use (Shift) in combination with the letter and number keys to type uppercase letters or the symbols indicated on the upper-right corner of the keys.
- Use ▲ or ▼ with (Shift) to go to the beginning of the previous or next block.
- Use ◀ or ▶ with (Shift) to go to the beginning or end of the current line.
- While selecting the settings, press (Space) to go back to the default item.
- Unless otherwise mentioned, press (Esc) to cancel any operation.
- Press (Home) to return to the home screen.
- Label length shown on LCD may slightly differ from the actual label length when printed.
GETTING STARTED

Power Supply and Tape cassette

When using AC adapter (AD-E001)
Insert the plug on the adapter cord into the AC adapter socket on the side of the machine. Insert the plug into the nearest standard electrical outlet.

When using six new AA alkaline batteries (LR6) or fully charged Ni-MH batteries (HR6)
Make sure that their poles point in the correct directions. To remove the batteries, reverse the installation procedure.

NOTE

• For memory back up, we recommend using AA alkaline batteries (LR6) or Ni-MH batteries (HR6) together when using the AC adapter.
• To safeguard and backup the P-touch’s memory, when the AC adapter is unplugged it is recommended to have AA alkaline batteries (LR6) or Ni-MH batteries (HR6) installed in the P-touch.
• When power is disconnected for more than two minutes, all text and format settings will be cleared. Any text files saved in the memory will also be cleared.
• Remove the batteries if you do not intend to use the P-touch for an extended period of time.
• Dispose of the battery at an appropriate collection point, not in the general waste stream. In addition, be sure to observe all applicable federal, state, and local regulations.
When storing or discarding the battery, wrap it (for example with cellophane tape), to prevent it from short-circuiting.

(Battery insulation example)
1. Cellophane tape
2. Alkaline or Ni-MH battery

**CAUTION**

USING A COMBINATION OF DIFFERENT BATTERIES (SUCH AS Ni-MH AND ALKALINE), MAY RESULT IN AN EXPLOSION. DISPOSE OF USED BATTERIES ACCORDING TO THE INSTRUCTIONS.

**Insert a Tape Cassette**

**NOTE**

- When inserting the tape cassette, make sure that the tape and ink ribbon do not catch on the print head.
- If you cannot close the tape cassette compartment cover, check to ensure the release lever is in the up position. If not, lift the lever, and then close the cover.
GETTING STARTED

Turning Power On/Off

Press ( ) to turn the P-touch on.
Press ( ) again to turn the P-touch off.

NOTE

Your P-touch has a power saving function that automatically turns itself off if no key is pressed within a certain time under certain operating conditions. Refer to “Specifications” on page 45.

Setting Language and Unit

■ Language
When you turn on the P-touch for the first time, you are asked to set the default language. Select language using ▼ or ▲, and then press (OK) or (Enter).

■ Unit
The default setting is [mm].

Feeding Tape
To feed the tape, press the following keys:

(Shift) + (.)

Setting LCD Display

■ LCD Contrast
The default setting is [0].
■ Back Light
The default setting is [On].

( ) ➔ [Backlight] ➔ (OK) or ( ) ➔ [On/Off] ➔ (OK) or

NOTE
• You can also set the back light setting by pressing ( ).
• Power can be saved when the back light is turned off.
• The back light is turned off automatically if there is no operation. It can be turned back on by pressing any key. The back light turns off when printing.

How to use the P-touch

■ Create a label with the P-touch

[GETTING STARTED]

Preparing the P-touch  P. 7

[CREATING A LABEL]
• Entering and Editing text  P. 15
• Entering Symbols  P. 17
• Entering Accented Characters  P. 19
• Using Auto-Format Layouts  P. 24

NOTE
In addition to entering text, the P-touch has a large range of formatting options.
Examples of labels you can create using the P-touch:
GETTING STARTED

[LABEL PRINTING]

- Printing a label P. 33
- Setting Tape Cutting Options P. 34
- Printing from the Label Collection P. 37

NOTE

Before printing, you can check the layout of your label using the preview function. Refer to “Previewing Labels” on page 33.

Example of the preview screen:

Create a label by connecting your labeller to a PC

[GETTING STARTED]

This labeller can be connected to a PC/Mac and used with the P-touch Editor software to create more elaborate labels. To use your labeller connected to a computer, attach your labeller to a computer via the included USB cable and install the P-touch Editor software and drivers.

Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-touch Editor</td>
<td>Makes it easy for anyone to create a wide variety of custom labels in complex layouts by using fonts, templates, and clip art.</td>
</tr>
<tr>
<td>Printer Driver</td>
<td>Lets you print labels from the connected P-touch when using P-touch Editor on your computer.</td>
</tr>
<tr>
<td>P-touch Update Software</td>
<td>Label collections can be downloaded and new label designs added to the P-touch. In addition, the software can be upgraded to the latest version.</td>
</tr>
</tbody>
</table>

Installer download website

- A CD-ROM is not included with this product.
- To download and install printer drivers and software such as the P-touch Editor 5.1 on your computer, visit our installer download website (www.brother.com/inst).
Printer drivers and software are also available to download individually from the list of available printer drivers and software on our support website below:

**Brother support website**
Please visit our support website at support.brother.com
You can find following information:
- Software downloads
- Manuals/Documents
- Frequently Asked Questions (Troubleshooting, Useful tips on using printer)
- Consumable information
- Latest OS compatibility information
The contents of this website are subject to change without notice.

**[CREATING A LABEL]**

- Connect the P-touch to your computer with the included USB cable.
- Launch the P-touch Editor Software.
- Enter the label text using P-touch Editor.
- Print the label.

Examples of labels you can create using the P-touch Editor:

- August Sales Report
  Overseas Sales Div.
- LBI CORP.
  Sales & Marketing Dept.
  Mike Barkley
EDITING A LABEL

Entering and Editing Text

Entering Text from the Keyboard

Entering Text from the Keyboard

Adding a New Line

Move the cursor to end of the current line and press (Enter).}

Line 1

<table>
<thead>
<tr>
<th>Caps HEL M</th>
<th>E</th>
<th>9 mm x 63 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Line 2

<table>
<thead>
<tr>
<th>Caps HEL M</th>
<th>E</th>
<th>9 mm x 63 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC</td>
<td>J</td>
<td></td>
</tr>
<tr>
<td>DEF</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Label image

ABC
DEF

NOTE

• There is a maximum number of lines of text that can be entered for each tape width. A maximum of 5 lines for 18 mm tape, 3 lines for 12 mm tape, 2 lines for 9 mm and 6 mm tape, and 1 line for 3.5 mm tape.

• If you press (Enter) when five lines already exist, [Too Many Lines!] is displayed. Press (Esc) or any other key to clear the error message.

Adding a New Block

To create a new block of text/lines to the right of your current text, press (Shift) and (Enter). The cursor moves to the start of the new block.

NOTE

• A maximum of 5 blocks can be entered in one label.

• If you press (Shift) and (Enter) when five blocks already exist, [Too Many Blocks!] is displayed. Press (Esc) or any other key to clear the error message.

Deleting Text

By pressing (Esc), the letters will be deleted one by one.

To delete all text:

(Clear) ➔ ▲/▼ [Text Only] ➔ (OK) or (Enter).

To delete all text and format settings:

(Clear) ➔ ▲/▼ [Text&Format] ➔ (OK) or (Enter).
**Inserting a Tab**
To insert a tab, press the following key.
The symbol (Tab) will then appear on the screen.

**NOTE**
To delete a tab from a label, position the cursor to the right of the tab mark on the text entry screen and press (Esc).

To change tab length:

```
(Enter)  ▲/▼ [Tab Length]  (OK)  ▲/▼ [0 - 100 mm]  (OK)
```

**NOTE**
You can also set the tab length by typing in the desired tab length. To apply the setting, after typing in the tab length, press (OK) or (Enter) and then (OK) again.

**Using Text Reminder**
When a character is entered, the P-touch remembers character sequences beginning with the character entered from a history of all printed character sequences to date, and displays a list of options from which to select. The default setting is [On].

**Example:**

Enter “B” ➔ (OK) ➔ The P-touch displays a list of words printed beginning with the letter “B” such as “Brother” ➔ ▲/▼ Select the desired word ➔ Press ▶ to display the entire word that is too long to display on the list of words. To return to the list of words, press ◀ ➔ Press (OK) or (Enter), the selected character word will then appear on the text line.

**NOTE**
To close the list of words and return to the text entry screen, press (Esc).
**Entering Symbols**

### Entering Symbols Using the Symbol Function

(Enter)  [Settings]  (OK) or (Enter)  [Text Reminder]  (OK) or (Enter)  [Clear Memory]  (OK) or (Enter)  [On/Off]  (OK) or (Enter)

### Setting Symbol History

Up to 30 recently used symbols are added to [History]. The default setting is [On].

(Enter)  [Settings]  (OK) or (Enter)  [Text Reminder]  (OK) or (Enter)  [On/Off]  (OK) or (Enter)

---

### Symbol List

<table>
<thead>
<tr>
<th>Category</th>
<th>Symbols</th>
</tr>
</thead>
<tbody>
<tr>
<td>Punctuation</td>
<td>. , : ; &quot; ’ ? ! ¿ ¡ i – &amp; ~ _ \</td>
</tr>
<tr>
<td>Bracket Arrow</td>
<td>( ) [ ] &lt; &gt; « » [ ] → ← ↑ ↓</td>
</tr>
<tr>
<td>Mathematics</td>
<td>+ – × ÷ ± = ≥ ≤ ≠ : . σ β γ δ μ Ω</td>
</tr>
<tr>
<td></td>
<td>φ ∑ a b c 2 3 2 3 1/4 1/2 3/4 I II III IV V</td>
</tr>
<tr>
<td>Currency Unit</td>
<td>% $ ¢ € £ ¥ ṭ ᵇ ° ft. in. m f m c ¢ £ oz lb. °F °C</td>
</tr>
<tr>
<td>(Number)</td>
<td>① - ⑳</td>
</tr>
<tr>
<td>[Number]</td>
<td>1 - 99</td>
</tr>
<tr>
<td>Category</td>
<td>Symbols</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Sign</td>
<td><img src="image" alt="Sign Symbols" /></td>
</tr>
<tr>
<td>Electrical</td>
<td><img src="image" alt="Electrical Symbols" /></td>
</tr>
<tr>
<td>Datacom/AV</td>
<td><img src="image" alt="Datacom/AV Symbols" /></td>
</tr>
<tr>
<td>Business</td>
<td><img src="image" alt="Business Symbols" /></td>
</tr>
<tr>
<td>Professional</td>
<td><img src="image" alt="Professional Symbols" /></td>
</tr>
<tr>
<td>Event</td>
<td><img src="image" alt="Event Symbols" /></td>
</tr>
<tr>
<td>Vehicle</td>
<td><img src="image" alt="Vehicle Symbols" /></td>
</tr>
<tr>
<td>Personal</td>
<td><img src="image" alt="Personal Symbols" /></td>
</tr>
<tr>
<td>Nature/Earth</td>
<td><img src="image" alt="Nature/Earth Symbols" /></td>
</tr>
<tr>
<td>Pictograph</td>
<td><img src="image" alt="Pictograph Symbols" /></td>
</tr>
</tbody>
</table>
## Entering Accented Characters

Enter the character ➔ (Accent) ➔ ▲/▼ Select accented character ➔ (OK) or (Enter).  

### Accented Character List

<table>
<thead>
<tr>
<th>Character</th>
<th>Accented Characters</th>
<th>Character</th>
<th>Accented Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>á á á á æ á á á á</td>
<td>n</td>
<td>ñ ñ ñ ñ</td>
</tr>
<tr>
<td>A</td>
<td>Å Å Å Å Æ Å Å Å Å</td>
<td>N</td>
<td>Ń Ń Ń Ń</td>
</tr>
<tr>
<td>c</td>
<td>ç ç ç</td>
<td>o</td>
<td>ò ò ò œ œ œ</td>
</tr>
<tr>
<td>C</td>
<td>Ç Ç Ç</td>
<td>O</td>
<td>ò ò ò œ œ œ</td>
</tr>
<tr>
<td>d</td>
<td>d’ ð d</td>
<td>r</td>
<td>ř ř ř</td>
</tr>
<tr>
<td>D</td>
<td>Đ Đ</td>
<td>R</td>
<td>Ř Ř Ř</td>
</tr>
<tr>
<td>e</td>
<td>é è ê ê ê ê ê ê</td>
<td>s</td>
<td>š š š š š</td>
</tr>
<tr>
<td>E</td>
<td>É É É É Ÿ Ÿ Ÿ Ÿ Ÿ</td>
<td>S</td>
<td>Š Š Š Š Š</td>
</tr>
<tr>
<td>g</td>
<td>ġ ĝ</td>
<td>t</td>
<td>ť ť Ť</td>
</tr>
<tr>
<td>G</td>
<td>Ġ Ġ</td>
<td>T</td>
<td>Ė Ė Ė Ė Ė</td>
</tr>
<tr>
<td>i</td>
<td>í í í í í í í í</td>
<td>u</td>
<td>ũ ũ ũ ũ ũ ũ</td>
</tr>
<tr>
<td>I</td>
<td>ĭ ĭ ĭ ĭ ĭ ĭ ĭ ĭ</td>
<td>U</td>
<td>Ţ Ţ Ţ Ţ Ţ Ţ Ţ Ţ</td>
</tr>
<tr>
<td>k</td>
<td>k</td>
<td>y</td>
<td>ų ų</td>
</tr>
<tr>
<td>K</td>
<td>ķ</td>
<td>Y</td>
<td>ų ų</td>
</tr>
<tr>
<td>l</td>
<td>l l l'</td>
<td>z</td>
<td>ź ź ź</td>
</tr>
<tr>
<td>L</td>
<td>Ł Ł Ł'</td>
<td>Z</td>
<td>Ź Ź Ź</td>
</tr>
</tbody>
</table>
Setting Character Attributes ([Font]/[Size]/[Width]/[Style]/[Line]/[Align])

You can set character attributes by label or by each line both before and after entering text.

■ Setting Character Attributes by Label

*(Font)* ➔ ▲/▼ Select an attribute ➔ (OK) or (Enter) ➔ ▲/▼ Set a value for that attribute ➔ (OK) or (Enter) ➔ (Esc) to return to the text entry screen.

■ Setting Character Attributes by Each Line

1. Using ▲/▼, move the cursor to the line you wish to change the character attribute.
2. Press (Shift) and (Font) to display the attributes.

NOTE

- ( ) displayed on the left side of the character attribute that appears when you press (Shift) and (Font) indicates that you are now applying the attribute for that specific line only.
- When different attribute values are set for each line, the value will be displayed as ****** when you press (Font), select an attribute using ▲ or ▼, and then press (OK) or (Enter). When you change the setting on this screen by using ▲ or ▼, pressing (OK) or (Enter), and then pressing (Esc) to go back to the text entry screen, the same change will be applied to all lines of the label.
- The actual printed font size depends on the tape width, number of characters and number of input lines. Once characters reach a minimum size, the selected font will default to a custom font which is based on the Helsinki style. This allows labels to print using the smallest text possible on narrow or multi-line labels.
- The 6 point font only prints in Helsinki, no other font type.
- When [Size] is set to [Auto] and all the text is entered in uppercase, the text is automatically adjusted to print in the largest font size possible for each tape width. This font size is larger than the largest font size available in the font settings for each tape width.
### Setting Options

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
<th>Result</th>
<th>Attribute</th>
<th>Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Helsinki</td>
<td>A1</td>
<td>Font</td>
<td>Belgium</td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td>Brussels</td>
<td>A1</td>
<td></td>
<td>Atlanta</td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td>US</td>
<td>A1</td>
<td></td>
<td>Adams</td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td>Los Angeles</td>
<td>A1</td>
<td></td>
<td>Brunei</td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td>San Diego</td>
<td>A1</td>
<td></td>
<td>Sofia</td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td>Florida</td>
<td>A1</td>
<td></td>
<td>Germany</td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td>Calgary</td>
<td>A1</td>
<td></td>
<td>Letter Gothic</td>
<td>A1</td>
</tr>
<tr>
<td>Size</td>
<td>Auto</td>
<td></td>
<td>Size</td>
<td>18 pt</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>24 pt</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>36 pt</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>42 pt</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>6 pt</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>9 pt</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12 pt</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Width</td>
<td>x 1</td>
<td>A</td>
<td></td>
<td>x 1/2</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>x 3/2</td>
<td>A</td>
<td></td>
<td>x 2/3</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>x 2</td>
<td>A</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

When Auto is selected, the text is automatically adjusted to print in the largest size available in the font settings for each tape width.
EDITING A LABEL

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
<th>Result</th>
<th>Attribute</th>
<th>Value</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>Normal</td>
<td>A</td>
<td>Style</td>
<td>Italic Bold</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>Bold</td>
<td>A</td>
<td></td>
<td>Italic Outline</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>Outline</td>
<td>A</td>
<td></td>
<td>Italic Shadow</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>Shadow</td>
<td>A</td>
<td></td>
<td>Italic Solid</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>Solid</td>
<td>A</td>
<td></td>
<td>Vertical</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>Italic</td>
<td>A</td>
<td></td>
<td>Vertical Bold</td>
<td>A</td>
</tr>
<tr>
<td>Line</td>
<td>Off</td>
<td>A</td>
<td>Line</td>
<td>Strikeout</td>
<td>A</td>
</tr>
<tr>
<td>Underline</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Align</td>
<td>Left</td>
<td>ABC</td>
<td>Align</td>
<td>Right</td>
<td>ABC</td>
</tr>
<tr>
<td></td>
<td>Center</td>
<td>ABC</td>
<td></td>
<td>Justify</td>
<td>A B C</td>
</tr>
</tbody>
</table>

**Setting Auto Fit Style**

When [Size] is set to [Auto] and [Length] is set to a specific length, you can reduce the text size to fit within the label length. When [Text Size] is selected, the total text size is modified to fit within the label. When [Text Width] is selected, the text width will be reduced to the size of x1/2 setting.

```plaintext
( ) ➔ [Settings] ➔ (OK) or (Enter) ➔ ▲/▼ [Auto Fit Style] ➔ (OK) or (Enter) ➔ ▲/▼ [Text Size/Text Width] ➔ (OK) or (Enter).
```

**Setting Frames**

```plaintext
( ) ➔ ▲/▼ / ➔ Select a frame ➔ (OK) or (Enter).
```

**NOTE**

You can also select a frame by typing in the frame number.
EDITING A LABEL

Frames

<table>
<thead>
<tr>
<th>Frames</th>
<th>Frames</th>
<th>Frames</th>
<th>Frames</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td></td>
<td>12</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td></td>
<td>14</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td>16</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td></td>
<td>18</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td></td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td></td>
<td>22</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td></td>
<td>24</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td></td>
<td>26</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td></td>
<td>28</td>
<td></td>
</tr>
<tr>
<td>29</td>
<td></td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td></td>
<td>32</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td></td>
<td>34</td>
<td></td>
</tr>
<tr>
<td>35</td>
<td></td>
<td>36</td>
<td></td>
</tr>
<tr>
<td>37</td>
<td></td>
<td>38</td>
<td></td>
</tr>
<tr>
<td>39</td>
<td></td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>41</td>
<td></td>
<td>42</td>
<td></td>
</tr>
<tr>
<td>43</td>
<td></td>
<td>44</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td></td>
<td>46</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td></td>
<td>48</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td></td>
<td>50</td>
<td></td>
</tr>
<tr>
<td>51</td>
<td></td>
<td>52</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td></td>
<td>54</td>
<td></td>
</tr>
<tr>
<td>55</td>
<td></td>
<td>56</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td></td>
<td>58</td>
<td></td>
</tr>
<tr>
<td>59</td>
<td></td>
<td>60</td>
<td></td>
</tr>
<tr>
<td>61</td>
<td></td>
<td>62</td>
<td></td>
</tr>
<tr>
<td>63</td>
<td></td>
<td>64</td>
<td></td>
</tr>
<tr>
<td>65</td>
<td></td>
<td>66</td>
<td></td>
</tr>
<tr>
<td>67</td>
<td></td>
<td>68</td>
<td></td>
</tr>
<tr>
<td>69</td>
<td></td>
<td>70</td>
<td></td>
</tr>
<tr>
<td>71</td>
<td></td>
<td>72</td>
<td></td>
</tr>
<tr>
<td>73</td>
<td></td>
<td>74</td>
<td></td>
</tr>
<tr>
<td>75</td>
<td></td>
<td>76</td>
<td></td>
</tr>
<tr>
<td>77</td>
<td></td>
<td>78</td>
<td></td>
</tr>
<tr>
<td>79</td>
<td></td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>81</td>
<td></td>
<td>82</td>
<td></td>
</tr>
<tr>
<td>83</td>
<td></td>
<td>84</td>
<td></td>
</tr>
<tr>
<td>85</td>
<td></td>
<td>86</td>
<td></td>
</tr>
<tr>
<td>87</td>
<td></td>
<td>88</td>
<td></td>
</tr>
<tr>
<td>89</td>
<td></td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>91</td>
<td></td>
<td>92</td>
<td></td>
</tr>
<tr>
<td>93</td>
<td></td>
<td>94</td>
<td></td>
</tr>
<tr>
<td>95</td>
<td></td>
<td>96</td>
<td></td>
</tr>
<tr>
<td>97</td>
<td></td>
<td>98</td>
<td></td>
</tr>
<tr>
<td>99</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Setting Frames
Setting Label Attributes ([Length]/[Cut Option]/[Tab Length])

Length: [Length] can be set within the range 30 mm - 300 mm. When [Auto] is selected, the length of the label is automatically adjusted based on the amount of text entered.

Cut Option: Refer to “Setting Tape Cutting Options” on page 34.

Tab Length: Refer to “To change tab length:” on page 16.

[Label] → ▲/▼ Select an attribute → (OK) or (Enter) → ▲/▼ Set a value for that attribute → (OK) or (Enter) → (Esc) to return to the text entry screen.

NOTE

You can also set the label and tab length by typing in the desired length. To apply the setting, after typing in the length, press (OK) or (Enter) and then (OK) or (Enter) again.

Using Auto-Format Layouts

Using Templates

Simply select a layout from the templates, enter the text and apply formatting as desired.

Example - Asset Tag:

( ) → ▲/▼ [Auto Format] → (OK) or (Enter) → ▲/▼ [Templates] → (OK) or (Enter) → ▲/▼ [Asset Management] → (OK) or (Enter) → ▲/▼ [Asset Tag] → (OK) or (Enter) → Enter the text → (OK) or (Enter) → Enter the text for the next field → (OK) or (Enter) → ▲/▼ Select an attribute for barcode → ▲/▼ Set a value for that attribute → (OK) or (Enter) → Type in the barcode data → (OK) or (Enter) → ▲/▼ [Print] → (OK) or (Enter) → ▲/▼ Select the number of labels to be printed → (Print), (OK) or (Enter).
NOTE

• For details on barcodes, refer to “Creating a Barcode Label” on page 30.
• On the print menu screen:
  • Select [Edit] to change the text data or the barcode setup.
  • Select [Save] to store the label to the file memory.
    For the file memory, refer to “USING THE FILE MEMORY” on page 39.
  • Select [Menu] to change the font or style settings.
  • Select [Preview] to preview the label before printing.
  • Select [Print Options] to set the print settings. For details, refer to “Numbering Printing” on page 34 or “Mirror Printing” on page 34.
• If the width of the current tape cassette does not match the set width for the selected layout, an error message is displayed when you try to print the label. Press (Esc) or any other key to clear the error message, and insert a tape cassette of the correct width.
• If the number of characters entered exceeds the limit, [Text Too Long!] is displayed when (OK) or (Enter) is pressed. Press (Esc) or any other key to clear the error message, and edit the text using fewer characters.

### Templates

<table>
<thead>
<tr>
<th>Category</th>
<th>Value</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Management</td>
<td>Asset Tag</td>
<td>(18 mm × 70 mm)</td>
</tr>
<tr>
<td>Bin Box</td>
<td>(18 mm × 76 mm)</td>
<td></td>
</tr>
<tr>
<td>Equipment Label</td>
<td>(18 mm × 58 mm)</td>
<td></td>
</tr>
<tr>
<td>Category</td>
<td>Value</td>
<td>Details</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>Binder Spine</td>
<td>[Image of Binder Spine]</td>
<td>(18 mm × 219 mm)</td>
</tr>
<tr>
<td>File Folder Tab</td>
<td>[Image of File Folder Tab] PAYABLES</td>
<td>(12 mm × 82 mm)</td>
</tr>
<tr>
<td>Divider Tab (Hanging</td>
<td>[Image of Divider Tab] AUGUST</td>
<td>(12 mm × 42 mm)</td>
</tr>
<tr>
<td>Cabinet Label</td>
<td>[Image of Cabinet Label] Office Supplies</td>
<td>(18 mm × 111 mm)</td>
</tr>
<tr>
<td>Address Label</td>
<td>ABC CORPORATION 1234 Main St, Anytown, USA 12345 Telephone (XXX) XXX-XXXX</td>
<td>(18 mm × 70 mm)</td>
</tr>
<tr>
<td>Name Badge 1</td>
<td>[Image of Name Badge 1] Brother brother</td>
<td>(18 mm × 72 mm)</td>
</tr>
<tr>
<td>Name Badge 2</td>
<td>Robert Becker ABC Company, Inc.</td>
<td>(18 mm × 72 mm)</td>
</tr>
<tr>
<td>SD Card Label</td>
<td>[Image of SD Card Label] Photos September'14 Trip</td>
<td>(12 mm × 25 mm)</td>
</tr>
<tr>
<td>USB Flash Memory</td>
<td>[Image of USB Flash Memory] Sales Meeting 1/15</td>
<td>(9 mm × 25 mm)</td>
</tr>
<tr>
<td>CD Case Spine 1</td>
<td>[Image of CD Case Spine 1] My Favorite Music</td>
<td>(6 mm × 113 mm)</td>
</tr>
<tr>
<td>CD Case Spine 2</td>
<td>[Image of CD Case Spine 2] My Favorite Music</td>
<td>(3.5 mm × 113 mm)</td>
</tr>
</tbody>
</table>
EDITING A LABEL

<table>
<thead>
<tr>
<th>Category</th>
<th>Value</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cable Labeling</td>
<td>Flag 1</td>
<td>(12 mm × 90 mm)</td>
</tr>
<tr>
<td></td>
<td>Flag 2</td>
<td>(12 mm × 90 mm)</td>
</tr>
<tr>
<td></td>
<td>Cable Wrap</td>
<td>(18 mm × 39 mm)</td>
</tr>
<tr>
<td></td>
<td>Faceplate (VRT)</td>
<td>(12 mm × 70 mm)</td>
</tr>
</tbody>
</table>

Using Block Layouts
Simply select a layout from the block layouts, enter the text and apply formatting as desired.

( ) ➔ ▲/▼ [Auto Format] ➔ (OK) or (Enter) ➔ ▲/▼ [Block Layouts] ➔ (OK) or (Enter) ➔ ▲/▼ Select a tape width ➔ (OK) or (Enter) ➔ ▲/▼ Select a block layout ➔ (OK) or (Enter) ➔ Enter the text ➔ (OK) or (Enter) ➔ Repeat for each text field ➔ (OK) or (Enter) to display the print menu ➔ ▲/▼ [Print] ➔ (OK) or (Enter) ➔ ▲/▼ Select the number of labels to be printed ➔ (Print), (OK) or (Enter).

NOTE

- On the print menu screen:
  - Select [Edit] to change the text data or the barcode setup.
  - Select [Save] to store the label to the file memory.
  - Select [Menu] to change the font, align or frame settings.
  - Select [Preview] to preview the label before printing.
  - Select [Print Options] to set the print settings. For details, refer to “Numbering Printing” on page 34 or “Mirror Printing” on page 34.
• If the width of the current tape cassette does not match the set width for the selected layout, an error message is displayed when you try to print the label. Press (Esc) or any other key to clear the error message, and insert a tape cassette of the correct width.

### Block Layouts

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>2LineA</td>
<td></td>
<td><img src="image1.png" alt="Image" /> 12pt 24pt</td>
</tr>
<tr>
<td>2LineB</td>
<td></td>
<td><img src="image2.png" alt="Image" /> 24pt 12pt</td>
</tr>
<tr>
<td>3Line</td>
<td></td>
<td><img src="image3.png" alt="Image" /> 9pt 9pt 24pt</td>
</tr>
<tr>
<td>1+2LineA</td>
<td>42pt</td>
<td><img src="image4.png" alt="Image" /> 18pt 18pt</td>
</tr>
<tr>
<td>1+2LineB</td>
<td>42pt</td>
<td><img src="image5.png" alt="Image" /> 12pt 24pt</td>
</tr>
<tr>
<td>1+3Line</td>
<td>42pt</td>
<td><img src="image6.png" alt="Image" /> 12pt</td>
</tr>
<tr>
<td>1+4Line</td>
<td>42pt</td>
<td><img src="image7.png" alt="Image" /> 9pt</td>
</tr>
<tr>
<td>1+5Line</td>
<td>42pt</td>
<td><img src="image8.png" alt="Image" /> 9pt</td>
</tr>
</tbody>
</table>
### EDITING A LABEL

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>12mm</td>
<td>2LineA</td>
<td><img src="image" alt="2LineA" /></td>
</tr>
<tr>
<td>12mm</td>
<td>2LineB</td>
<td><img src="image" alt="2LineB" /></td>
</tr>
<tr>
<td>12mm</td>
<td>3Line</td>
<td><img src="image" alt="3Line" /></td>
</tr>
<tr>
<td>12mm</td>
<td>1+2Line</td>
<td><img src="image" alt="1+2Line" /></td>
</tr>
<tr>
<td>9mm</td>
<td>2LineA</td>
<td><img src="image" alt="9mm 2LineA" /></td>
</tr>
<tr>
<td>9mm</td>
<td>2LineB</td>
<td><img src="image" alt="9mm 2LineB" /></td>
</tr>
<tr>
<td>9mm</td>
<td>1+2Line</td>
<td><img src="image" alt="9mm 1+2Line" /></td>
</tr>
<tr>
<td>6mm</td>
<td>1+2Line</td>
<td><img src="image" alt="6mm 1+2Line" /></td>
</tr>
</tbody>
</table>
Creating a Barcode Label

NOTE

- The P-touch is not designed exclusively for creating barcode labels. Always check that barcode labels can be read by the barcode reader.
- For best results, print barcode labels in black ink on white tape. Some barcode readers may not be able to read barcode labels created using coloured tape or ink.
- Use the [Large] setting for [Width] whenever possible. Some barcode readers may not be able to read barcode labels created using the [Small] setting.
- Continuously printing a large number of labels with barcodes can overheat the print head, which may affect printing quality.

Setting Barcode Parameters and Entering Barcode Data

1. (Bar Code) ➔ ▲/▼ Select an attribute ➔ ◀/▶ Set a value for that attribute ➔ (OK) or (Enter) ➔ Type in the barcode data ➔ (Symbol) ➔ ▲/▼ Select a character ➔ (OK) or (Enter) ➔ (OK) or (Enter).

NOTE

Symbols are only available for the CODE39, CODE128, CODABAR or GS1-128 protocols. When not using symbols, after typing in the barcode data, press (OK) or (Enter) to insert the barcode in the label.
## Barcode Settings

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Protocol</strong></td>
<td><strong>CODE39, CODE128, EAN-8, EAN-13, GS1-128 (UCC/EAN-128), UPC-A, UPC-E, I-2/5 (ITF), CODABAR</strong></td>
</tr>
<tr>
<td><strong>Width</strong></td>
<td>Small</td>
</tr>
<tr>
<td></td>
<td>Large</td>
</tr>
<tr>
<td><strong>Under#</strong></td>
<td>On</td>
</tr>
<tr>
<td>(characters printed below barcode)</td>
<td>Off</td>
</tr>
<tr>
<td><strong>C.Digit</strong></td>
<td>Off</td>
</tr>
<tr>
<td>(check digit)</td>
<td>On</td>
</tr>
<tr>
<td></td>
<td>(only available for the CODE39, I-2/5 and CODABAR protocols)</td>
</tr>
</tbody>
</table>

### Special Character List

<table>
<thead>
<tr>
<th>CODE39</th>
<th>CODABAR</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Special Character</strong></td>
<td><strong>Special Character</strong></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>.</td>
<td>$</td>
</tr>
<tr>
<td>(SPACE)</td>
<td>$</td>
</tr>
<tr>
<td>$</td>
<td>:</td>
</tr>
<tr>
<td>/</td>
<td>/</td>
</tr>
<tr>
<td>+</td>
<td>.</td>
</tr>
<tr>
<td>%</td>
<td>+</td>
</tr>
</tbody>
</table>
# Editing a Label

## CODE128, GS1-128 (UCC / EAN-128)

<table>
<thead>
<tr>
<th>Special Character</th>
<th>(SPACE)</th>
<th>!</th>
<th>”</th>
<th>#</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>%</td>
<td>&amp;</td>
<td>'</td>
<td></td>
</tr>
<tr>
<td>(</td>
<td>)</td>
<td>*</td>
<td>+</td>
<td></td>
</tr>
<tr>
<td>–</td>
<td>.</td>
<td></td>
<td>/</td>
<td></td>
</tr>
<tr>
<td>:</td>
<td>;</td>
<td>&lt;</td>
<td>=</td>
<td></td>
</tr>
<tr>
<td>&gt;</td>
<td>?</td>
<td>@</td>
<td>[</td>
<td></td>
</tr>
<tr>
<td>\</td>
<td>]</td>
<td>^</td>
<td>_</td>
<td></td>
</tr>
<tr>
<td>NUL</td>
<td>.</td>
<td>SOH</td>
<td>STX</td>
<td></td>
</tr>
<tr>
<td>ETX</td>
<td>EOT</td>
<td>ENQ</td>
<td>ACK</td>
<td></td>
</tr>
<tr>
<td>BEL</td>
<td>BS</td>
<td>HT</td>
<td>LF</td>
<td></td>
</tr>
<tr>
<td>VT</td>
<td>FF</td>
<td>CR</td>
<td>SO</td>
<td></td>
</tr>
<tr>
<td>SI</td>
<td>DLE</td>
<td>DC1</td>
<td>DC2</td>
<td></td>
</tr>
<tr>
<td>DC3</td>
<td>DC4</td>
<td>NAK</td>
<td>SYN</td>
<td></td>
</tr>
<tr>
<td>ETB</td>
<td>CAN</td>
<td>EM</td>
<td>SUB</td>
<td></td>
</tr>
<tr>
<td>ESC</td>
<td>{</td>
<td>FS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GS</td>
<td>}</td>
<td>RS</td>
<td>~</td>
<td></td>
</tr>
<tr>
<td>US</td>
<td>DEL</td>
<td>FNC3</td>
<td>FNC2</td>
<td></td>
</tr>
<tr>
<td>FNC4</td>
<td>FNC1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Editing and Deleting a Barcode

To edit barcode parameters and barcode data, position the cursor to the left of the barcode mark on the data entry screen and then open the Barcode Setup screen by pressing (Bar Code).

To delete a barcode from a label, position the cursor to the right of the barcode mark on the data entry screen and press (GS).
**LABEL PRINTING**

**Previewing Labels**

You can preview the text before printing.

Press ◄, ►, ▲ or ▼ to scroll the preview to the left, right, top or bottom. Press (Zoom) to change the magnification of the preview.

**NOTE**

To scroll the preview to the left, right, top or bottom end, press (Shift) and ◄, ►, ▲ or ▼.

**Printing Labels**

To cut off the label, press the tape cutter lever on the upper left corner of the machine.

**NOTE**

- To prevent damage to the tape, do not touch the cutter lever while the message [Printing...Copies] or [Feeding Tape...Please Wait] is displayed.
- Do not pull the label coming out of the tape exit slot. Doing so will cause the ink ribbon to be discharged with the tape, making the tape no longer usable.
- Do not block the tape exit slot during printing or when feeding tape. Doing so will cause the tape to jam.

**Single and Multiple Copy Printing**

(Print) → ▲/▼ Change the number of copies → (Print), (OK) or (Enter).

**NOTE**

- If you need only 1 copy of the label, press (Print), (OK) or (Enter) without selecting the number of copies.
- The number of copies can also be specified by pressing a number key.
Numbering Printing

Select the highest number you wish to be printed when setting the number.

Mirror Printing

Use clear tape in [Mirror], so the labels can be read correctly from the opposite side when attached on glass, windows or other transparent surfaces.

Setting Tape Cutting Options

[Large Margin]/[Small Margin]/[Chain]/[No Cut]/[Special tape]

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Large Margin</td>
<td>Each label is printed, leaving a margin of 23.9 mm on each end.</td>
<td>ABC</td>
</tr>
<tr>
<td>Small Margin</td>
<td>A margin of 22.5 mm is printed first, and then each label is printed, leaving a margin of 4 mm before and after the text.</td>
<td>ABC</td>
</tr>
</tbody>
</table>
## Setting Tape Cutting Options

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| **Chain** | • Select this setting when printing several labels with minimum margins.  
• Feed the tape before using the cutter. Otherwise a part of the text may be cut off. Do not try to pull the tape since this may damage the tape cassette.  
• A margin of 22.5 mm is printed first, and then each label is printed, leaving a margin of 4 mm before and after the text. | ABC DEF |
| **No Cut** | • Select this setting when printing multiple copies of a label or when using Fabric Tapes or other special tapes that cannot be cut by the tape cutter of the P-touch.  
• Feed the tape before using the cutter. Otherwise a part of the text may be cut off. Do not try to pull the tape since this may damage the tape cassette.  
• When using the special tapes that cannot be cut by the tape cutter of the P-touch, remove the tape cassette from the P-touch and use scissors to cut the tape. | ABC |
### Adjusting the Label Length

When the tape cassette comes to the end, the printed length may be less accurate. In this case, you can adjust the label length.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
</table>
| Special tape| • Select this setting when using special tape.  
• When using Fabric Tapes or Heat Shrink Tube, set [Special tape] for [Cut Option] before printing. After printing, remove the tape cassette from the P-touch and use scissors to cut the tape. | ![Example](ABC ABC)  
23.9 mm 4 mm 4 mm  
- When multiple copies are printed one time:  
- When a label is printed two times:  
1 2  
23.9 mm 27.9 mm  
1. 1st print  
2. 2nd print |

#### NOTE

- When the cut option is set to [No Cut] or [Chain], it stops in the middle of printing area after the last label is printed. After [OK to Feed?] is displayed, press (OK) or (Enter) to feed the tape. Press (Esc) to return to the text entry screen.
- When the cut option is set to [Large Margin], [Small Margin], [Chain], after printing the message [Cut tape or press Enter to continue.] is displayed and the P-touch goes into the cut pause mode. By pressing the Tape cutter lever, you can cut the tape at the position you set in [Cut Option].

**Adjusting the Label Length**

When the tape cassette comes to the end, the printed length may be less accurate. In this case, you can adjust the label length.

1. Press (Settings)  
2. Press (OK) or (Enter)  
3. Press (Adjustment)  
4. Press (OK) or (Enter)  
5. Press (Label Length)  
6. Press (OK) or (Enter)  
7. Press ([-5 - +5] (OK)  
8. Press (Enter).  

#### NOTE

Approximately 1 % of the total label length will be adjusted by 1 level.
Printing from the Label Collection

Printing a label from the label collection stored in the P-touch

1. Press [Label Collection] → (OK) or (Enter) → △/▽ Select a category
2. (OK) or (Enter) → △/▽ Select a label
3. (OK) or (Enter) → △/▽ [Language] → (OK) or (Enter) → △/▽ [Croatian/Czech/Danish/Dutch/English(UK)/Finnish/French/German/Hungarian/Italian/ Norwegian/Polish/Portuguese/Romanian/Slovak/Slovenian/Spanish(Spain)/ Swedish/Turkish] → (OK) or (Enter) → △/▽ Check the label image → (OK) or (Enter) → △/▽ [Print] → (OK) or (Enter) → △/▽ Select the number of copies → (Print), (OK) or (Enter).

NOTE

Only 12 mm or 18 mm tape can be used for Label Collection.

---

### Label Collection List

<table>
<thead>
<tr>
<th>Category</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Files</td>
<td><img src="image1" alt="Completed" /> <img src="image2" alt="Pending" /></td>
</tr>
<tr>
<td></td>
<td><img src="image3" alt="Personal" /> <img src="image4" alt="Prospects" /></td>
</tr>
<tr>
<td></td>
<td><img src="image5" alt="To Do" /></td>
</tr>
<tr>
<td>Office signage</td>
<td><img src="image6" alt="Be Quiet" /></td>
</tr>
<tr>
<td></td>
<td><img src="image7" alt="For Internal Use Only" /></td>
</tr>
<tr>
<td></td>
<td><img src="image8" alt="No Mobile Phones" /></td>
</tr>
<tr>
<td></td>
<td><img src="image9" alt="Authorised Personnel Only" /></td>
</tr>
<tr>
<td></td>
<td><img src="image10" alt="Use Other Door" /></td>
</tr>
<tr>
<td>Communication</td>
<td><img src="image11" alt="RESPOND IMMEDIATELY!" /></td>
</tr>
<tr>
<td></td>
<td><img src="image12" alt="Please sign and return" /></td>
</tr>
<tr>
<td></td>
<td><img src="image13" alt="For Your Information" /></td>
</tr>
<tr>
<td></td>
<td><img src="image14" alt="Interoffice Mail" /></td>
</tr>
<tr>
<td></td>
<td><img src="image15" alt="Outgoing" /></td>
</tr>
<tr>
<td></td>
<td><img src="image16" alt="Do Not Distribute" /></td>
</tr>
</tbody>
</table>
**LABEL PRINTING**

<table>
<thead>
<tr>
<th>Category</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attention</td>
<td><img src="image" alt="Danger" /> <img src="image" alt="Caution" /> <img src="image" alt="Urgent" /> <img src="image" alt="Confidential" /> <img src="image" alt="Important Documents Enclosed" /></td>
</tr>
<tr>
<td>Retail</td>
<td><img src="image" alt="Sample" /> <img src="image" alt="Special Offer" /> <img src="image" alt="Open Closed" /> <img src="image" alt="Sale" /></td>
</tr>
</tbody>
</table>

* Labels are for illustrative purposes only.

**Downloading a new Label Collection Category**

Using the P-touch Update Software, additional label collection categories can be downloaded to your labeller. To download the new label collection categories, please visit the Brother support website at: [support.brother.com](http://support.brother.com)
Saving Label Files

You can save up to 50 labels and recall them for printing at a later date. A maximum of 280 characters can be saved per file. You can also edit and overwrite the saved label.

Type text and format label → (Save) → ▲/▼ Select a file → (OK) or (Enter).

Printing, Opening, Deleting a Saved Label

**[Print]**

(▲) → ▲/▼ [File] → (OK) or (Enter) → ▲/▼ Select a file → (OK) or (Enter) → ▲/▼ [Print] → (OK) or (Enter) → ▲/▼ Select the number of copies → (Print), (OK) or (Enter).

**NOTE**

To print a saved label from the file select screen, select a label using ▲ or ▼ and then press (Print).

**[Open]**

(▲) → ▲/▼ [File] → (OK) or (Enter) → ▲/▼ Select a file → (OK) or (Enter) → ▲/▼ [Open] → (OK) or (Enter).

**NOTE**

If the message [Discard changes and open saved label?] appears, you have entered text on the text entry screen. Press (OK) or (Enter) to clear the entered text and open the saved label. Press (Esc) to cancel opening a saved label and return to the previous screen.

**[Delete]**

(▲) → ▲/▼ [File] → (OK) or (Enter) → ▲/▼ Select a file → (OK) or (Enter) → ▲/▼ [Delete] → (OK) or (Enter) → The message appears → (OK) or (Enter).

**NOTE**

To delete a saved label from the file select screen, select a label using ▲ or ▼ and then press (Clear).
Resetting the P-touch

You can reset the internal memory of your P-touch when you want to clear all saved label files, or in the event the P-touch is not operating correctly.

### Resetting the Data Using the home key

1. Press (Settings) ➔ (Reset)
2. Select the resetting method ➔ (Enter)
3. A confirmation message appears ➔ (Enter).

#### Value | Details
---|---
Reset All Settings | Downloaded labels are NOT cleared. The contents in the file memory are also NOT cleared. Other data is cleared and all settings are reset to the factory settings.
Erase All Content | Downloaded labels are cleared. The contents in the file memory are also cleared. Other data is NOT cleared and settings are NOT reset.
Factory Default | All labels and customised settings are reset to the factory settings.

### Resetting the Data to Factory Settings Using the P-touch Keyboard

- All text, format settings, option settings and saved label files are cleared when you reset the P-touch. Language and unit settings will also be cleared.
- You are asked to set the default language at the end of the resetting procedure. For details, refer to “Setting Language and Unit” on page 11.

---

**NOTE**

When selecting [Reset All Settings] or [Factory Default] for the resetting method, you are asked to set default language at the end of the resetting procedure.

---
**RESETTING & MAINTAINING YOUR P-TOUCH**

To reset all the labels and customised settings:
Turn off the P-touch. Press and hold down (Shift) and (GS).
While holding down (Shift) and (GS), press (Power) once and then release (Shift) and (GS).

**NOTE**

Release (Power) before releasing the other keys.

To reset the customised settings:
(Downloaded label collections and the contents in the file memory are not reset.)
Turn off the P-touch. Press and hold down (Shift) and (R). While holding down (Shift) and (R), press (Power) once and then release (Shift) and (R).

**NOTE**

Release (Power) before releasing the other keys.

**Maintenance**

**NOTE**

Always remove the batteries and disconnect the AC adapter before cleaning the P-touch.

**Cleaning the Unit**

Wipe any dust and marks from the main unit using a soft, dry cloth.
Use a slightly dampened cloth on difficult to remove marks.

**NOTE**

Do not use paint thinner, benzene, alcohol or any other organic solvent. These may deform the case or damage the appearance of your P-touch.
Cleaning the Print Head

Streaks or poor quality characters on printed labels generally indicates that the print head is dirty. Clean the print head using a cotton swab or the optional print head cleaning cassette (TZe-CL4).

**NOTE**

- Do not touch the print head directly with your bare hands.
- Refer to the instructions provided with the print head cleaning cassette for directions on how to use it.

Cleaning the Tape Cutter

Tape adhesive can build up on the cutter blade after repeated use, taking the edge off the blade which may result in the tape jamming in the cutter.

**NOTE**

- About once every year, wipe the cutter blade using a cotton swab moistened with Isopropyl alcohol (rubbing alcohol).
- Do not touch the cutter blade directly with your bare hands.
## TROUBLESHOOTING

### What to do when...

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The screen ‘locks’, or the P-touch does not respond normally.</td>
<td>• Refer to “Resetting the P-touch” on page 40 and reset the internal memory to the initial settings. If resetting the P-touch does not solve the problem, disconnect the AC adapter and remove the batteries for more than 10 minutes.</td>
</tr>
<tr>
<td>The display remains blank after turning on the power.</td>
<td>• Check that the batteries are correctly installed and that the AC adapter designed exclusively for your P-touch is correctly connected. Check that the rechargeable battery is fully charged.</td>
</tr>
<tr>
<td>The LCD messages are displayed in a foreign language.</td>
<td>• Refer to “Setting Language and Unit” on page 11 to select your desired language.</td>
</tr>
<tr>
<td>The label is not printed after pressing the Print key.</td>
<td>• Check that text has been entered and that the tape cassette is installed correctly with sufficient tape remaining.</td>
</tr>
<tr>
<td></td>
<td>• If the tape is bent, cut off the bent section and thread the tape through the tape exit slot.</td>
</tr>
<tr>
<td></td>
<td>• If the tape is jammed, remove the tape cassette and then pull out the jammed tape and cut it. Check that the end of the tape passes through the tape guide before reinstalling the tape cassette.</td>
</tr>
<tr>
<td>The label is not printed correctly.</td>
<td>• Remove the tape cassette and reinstall it, pressing it firmly until it clicks into place.</td>
</tr>
<tr>
<td></td>
<td>• If the print head is dirty, clean it with a cotton swab or optional print head cleaning cassette (TZe-CL4).</td>
</tr>
<tr>
<td>The ink ribbon is separated from the ink roller.</td>
<td>• If the ink ribbon is broken, replace the tape cassette. If not, leave the tape uncut and remove the tape cassette, then wind the loose ink ribbon onto the spool as shown in the figure.</td>
</tr>
<tr>
<td>The P-touch stops while printing a label.</td>
<td>• Replace the tape cassette if striped tape is visible, as this indicates that you have reached the end of the tape.</td>
</tr>
<tr>
<td></td>
<td>• Replace all batteries or connect the AC adapter directly to the P-touch.</td>
</tr>
<tr>
<td>Label files saved previously are now empty.</td>
<td>• All files saved in the internal memory are deleted if the batteries are weak or the AC adapter was disconnected.</td>
</tr>
</tbody>
</table>
TROUBLESHOOTING

When an error message appears on the display
When an error message appears on the display, follow the directions provided below.

<table>
<thead>
<tr>
<th>Message</th>
<th>Cause/Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check # of digits entered</td>
<td>The number of digits entered in the barcode data does not match the number of digits set in the barcode parameters. Enter the correct number of digits.</td>
</tr>
<tr>
<td>Cutter Malfunction!</td>
<td>The tape cutter has been closed when you tried to print or feed tape. Turn the P-touch off and then on again before continuing. When tape is tangled in the cutter, remove the tape.</td>
</tr>
<tr>
<td>Label Too Long!</td>
<td>The length of the label to be printed using the text entered is longer than 1 m. Edit the text so that the length of the label is less than 1 m.</td>
</tr>
<tr>
<td>Text Too Long!</td>
<td>The length of the label to be printed using the text entered is longer than the length setting. Edit the text to fit within the set length or change the length setting.</td>
</tr>
<tr>
<td>Unable to use XX!</td>
<td>Please contact Brother customer service.</td>
</tr>
</tbody>
</table>

**A tape jam which cannot be cleared keeps occurring.**

- Please contact Brother customer service.

**I do not know the version number of the firmware for the P-touch.**

- The version number and other information for the firmware can be confirmed by pressing the following keys:
  1. Press ( ).
  2. Select [Settings] using or , and then press (OK) or (Enter).
  3. Select [Version information] using or , and then press (OK) or (Enter).
## Specifications

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>Approx. 189 (W) × 177.5 (D) × 70.5 (H) mm</td>
</tr>
<tr>
<td>Weight</td>
<td>Approx. 740 g (without batteries and tape cassette)</td>
</tr>
<tr>
<td>Power supply</td>
<td>Six AA alkaline batteries (LR6), Six AA Ni-MH batteries (HR6)*1, AC adapter (AD-E001)</td>
</tr>
<tr>
<td>Character display</td>
<td>21 characters × 1 guidance and 3 lines text (320 dot × 120 dot)</td>
</tr>
<tr>
<td>Print height</td>
<td>15.8 mm max. (when using 18 mm tape)*2</td>
</tr>
<tr>
<td>Print speed</td>
<td>Maximum: Approx. 20 mm/sec. Actual print speed varies depending on the conditions.</td>
</tr>
<tr>
<td>Tape cassette</td>
<td>Standard TZe tape cassette (3.5 mm, 6 mm, 9 mm, 12 mm, 18 mm widths)</td>
</tr>
<tr>
<td>No. of lines</td>
<td>18 mm tape: 1 - 5 lines; 12 mm tape: 1 - 3 lines; 9 mm tape: 1 - 2 lines; 6 mm tape: 1 - 2 lines; 3.5 mm tape: 1 line</td>
</tr>
<tr>
<td>Memory buffer size</td>
<td>Maximum 2,800 characters</td>
</tr>
<tr>
<td>File storage</td>
<td>Maximum 50 files</td>
</tr>
<tr>
<td>Auto Power-off</td>
<td>Battery: 5 min.*3, AC adapter: 8 hours</td>
</tr>
<tr>
<td>Operation temperature/</td>
<td>10 °C - 35 °C / 20% - 80% humidity (without condensation)</td>
</tr>
<tr>
<td>humidity</td>
<td>Maximum wet bulb temperature: 27 °C</td>
</tr>
</tbody>
</table>

*1 Visit us at support.brother.com for the latest information about the recommended batteries.
*2 Actual character size may be smaller than maximum print height.
*3 When using P-touch only. When connected to a PC, 1 hour.
### System Requirements

<table>
<thead>
<tr>
<th>OS</th>
<th>Windows</th>
<th>Macintosh</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows Vista/Windows 7/ Windows 8/ Windows 8.1</td>
<td>OS X v10.7.5/10.8.x/10.9.x</td>
</tr>
<tr>
<td>Hard disk</td>
<td>Disk space: 70 MB or more</td>
<td>Disk space: 500 MB or more</td>
</tr>
<tr>
<td>Memory</td>
<td>Windows Vista: 512 MB or more&lt;br&gt;Windows 7: 1 GB or more (32-bit) or 2 GB or more (64-bit)&lt;br&gt;Windows 8/Windows 8.1: 1 GB or more (32-bit) or 2 GB or more (64-bit)</td>
<td>OS X v10.7.5: 2 GB or more&lt;br&gt;OS X v10.8.x: 2 GB or more&lt;br&gt;OS X v10.9.x: 2 GB or more</td>
</tr>
<tr>
<td>Monitor</td>
<td>SVGA, high colour or higher graphics card</td>
<td>256 colours or more</td>
</tr>
</tbody>
</table>

Please see the Brother support website ([support.brother.com](http://support.brother.com)) for the latest compatible OS.